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Using Constraints Tutorial

ﬁ IMPORTANT: This tutorial requires the use of the Kintex®-7 family of devices. You will
need to update your Vivado® tools installation if you do not have this device family
installed. Refer to the Vivado Design Suite User Guide: Release Notes, Installation, and
Licensing (UG973) for more information on Adding Design Tools or Devices.

Overview

This tutorial is comprised of two labs that demonstrate aspects of constraining a design in the Vivado
Design Suite. The constraints format supported by the Vivado Design Suite is called Xilinx® Design
Constraints (XDC), which is a combination of the industry standard Synopsys® Design Constraints and
proprietary Xilinx constraints.

-t
e

m VIDEO: You can also learn more about defining constraints in the Vivado Design Suite by
viewing the quick take video at Vivado Design Constraints Overview

TRAINING: Xilinx provides training courses that can help you learn more about the
concepts presented in this document. Use these links to explore related courses:

:l e Essentials of FPGA Design

~

e Vivado Design Suite Static Timing Analysis and Xilinx Design Constraints

e Vivado Advanced Tools and Techniques

XDCs are not just simple strings; they are Tcl commands that the Vivado Tcl interpreter sequentially
reads and parses. You can enter design constraints in several ways at different points in the design flow.
You can store XDCs in one or more files that can be added to a constraint set in Vivado Project Mode,
or read the same files directly into memory using the read xdc command in Non-Project mode. For
more information on Project and Non-Project modes, refer to the Vivado Design Suite User Guide:
Design Flows Overview (UG892). With a design open in Vivado tools, you can also type constraints as
commands directly in the Tcl console when working in the Vivado IDE or at the Tcl command prompt
when working outside of the IDE. This is particularly powerful for defining, validating, and debugging
new constraints interactively in the design.

The Vivado Design Suite synthesis and implementation tools are timing driven. Having accurate and
correct timing constraints is vital for meeting design goals and ensuring correct operation. Because the
Vivado tools are timing driven, it is important to fully constrain a design, but not over-constrain, or
under-constrain it. Over-constraining a design can lead to long run-times and sub-optimal results
because the tool can struggle with unrealistic design objectives. Under-constraining a design can cause
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the Vivado tools to perform unnecessary optimizations, such as examining paths with multicycle delays
or false paths, and prevent focus on the real critical paths.

This tutorial discusses different methods for defining and applying design constraints.

Tutorial Design Description

The sample design used throughout this tutorial consists of a small design called
project cpu netlist. Thereis a top-level EDIF netlist source file, as well as an XDC constraints file.

The design targets an XC7K70T device. A small design is used to allow the tutorial to be run with
minimal hardware requirements and to enable timely completion of the tutorial, as well as to minimize
the data size.

Hardware and Software Requirements

This tutorial requires that the 2016.3 Vivado Design Suite software release or later is installed.

See the Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973) for a
complete list and description of the system and software requirements.

Preparing the Tutorial Design Files

You can find a ZIP file containing the files for this tutorial in the examples directory of the Vivado
Design Suite software installation, at the following location:

<Vivado install area>/Vivado/<version>/examples/Vivado Tutorial.zip
Extract the ZIP file contents from the software installation into any write-accessible location.

The location of the extracted Vivado Tutorial directory is referred to as the <Extract Dir>in
this Tutorial.

You can also extract the provided ZIP file at any time to restore the files to their starting condition.

Note: You will modify the tutorial design data while working through this tutorial. Use a new copy of
the original Vivado Tutorial directory each time you start this tutorial.
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Lab 1: Defining Timing Constraints and Exceptions

Introduction

In this lab, you will learn two methods of creating constraints for a design. You will use the
Kintex®-7 CPU Netlist example design that is included in the Vivado® IDE.

Step 1: Opening the Example Project

Open Vivado IDE:

On Linux:

1. Change to the directory where the lab materials are stored:

cd <Extract Dir>/Vivado Tutorial

2. Launch the Vivado IDE: vivado

On Windows:
1. Launch the Vivado Design Suite IDE:
Start > All Programs > Xilinx Design Tools > Vivado 2018.x > Vivado 2018.x

Note: Your Vivado Design Suite installation might be called something other than Xilinx Design
Tools on the Start menu.

Note: As an alternative, click the Vivado 2018.x Desktop icon to start the Vivado IDE.

The Vivado IDE Getting Started page contains links to open or create projects and to view
documentation.

2. From the Getting Started page, click Open Example Project, as shown in the following figure.
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Quick Start

Create Proj
Open

Open Example Project >

Xilinx Tcl Store >

Learning Center

Documentation and Tutorials >
Quick Take Videos »

Release Notes Guide »

Figure 1: Open Example Project

The Open Example Project wizard opens to the Open Example Project page, as shown in the
following figure.
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Open Example Project

Create an Example Project

[ ]
VlVADO This wizard will guide you through the creation of a new Vivado project from a
HLx Editions predefined template.

To create a Vivado project you will specify the type of template project you would
like to create. Next, you will need to provide a name and a location for your project

files and choose a default board.

& XILINX

ALL PROGRAMMABLE.

Figure 2: Create an Example Project Page of the Open Example Project Wizard

3. Click Next.
4. In the Select Example Project page, select CPU (Synthesized), as shown in the following figure.
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Open Example Project

Select Project Template

Select one ofthe below predefined templates on which to base your new project ‘
Templates Description
Base MicroBlaze CPU {Synthesized)
Base Zynq Large synthesized netlist project
BFT
Configurable Microblaze Design .
Configurable ZYNQUS+MPS0OC Design GT IOS WIShbone
CPU (HDL)
& Clock
Wavegen (HDL)
Open RISC CPU USB
0
FFT UsB
. BFT 1
Engine
< ?

Figure 3: Select Example Project Page of the Open Example Project Wizard

5. Click Next.
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Lab 1: Defining Timing Constraints and Exceptions

6. In the Project Name page, specify the project name and location, as shown in the following figure.

Open Example Project

Project Name

Enter a name for your project and specify a directory where the project data files will be stored
Project name: project_cpu_netlist
Project location:  C:/Vivado_Tutaorial

+' Create project subdirectory

Project will be created at: C:/Vivado_Tutorialiproject_cpu_netlist

Cancel

Figure 4: Project Name Page of the Open Example Project Wizard

7. Specify the following:
o Project name: project_cpu_netlist
o Project location: <Extract_Dir>

8. Click Next.
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9. In the Default Part page, select the default part as shown in the following figure.

A Open Example Project

Default Part

Choose a default Xilinx part for your project. This can be changed later.

Search: . w
Part I/Q Pin Count  Available I0Bs  LUT Elements  FlipFlops  Block RAMs  Ultra RAMs
¥cTk70tbgETE-2 676 300 41000 82000 135 0

DSPs Gb’
240 8

Cancel

Figure 5: Default Part Page of the Open Example Project Wizard
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A New Project Summary appears, as shown in the following figure.

Open Example Project

New Project Summary

VIVADO'

HLx Editions o Anew project named ‘project_cpu_netlist will be created from the 'CPU
(Synthesized) template.

o The default part and product family for the new project:
Default Part xc7 k7 0fbg676-2
Product: Kintex-7
Family: Kintex-7
Package: fbg676
Speed Grade: -2

& XILINX

ALL PROGRAMMABLE= To create the pI'CIJEC't, click Finish

Figure 6: New Project Summary Page of the Open Example Project Wizard

10. Click Finish to finish creating the project.
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The Vivado IDE displays the default view of the opened project, as shown in the following figure.

Lab 1: Defining Timing Constraints and Exceptions

File Edit  Flow Tools  Window Layout View Help Quicl S8 Ready
B = | 2 I - TN 95 Default Layout -
a a
Flow Navigator = S PROJECT MANAGER project_cpu_netlist ? X
~  PROJECT MANAGER Sources ? 006 X Project Summary 700 %
£ Settings Q T 2 4+ u o a
- hd Fa
Settings  Edit
Add Sources » Design Sources (1) =
Language Templates ~ Constraints (2) Biiediaame: project cpu_netlist
S constrs_2 (1) (active) Project location C:/Vivado_Tutorialiproject_cpu_netlist
~  SIMULATION > constrs_1 (1) Product family: Kintex-7
Run Simulation ~ Simulation-Only Sources (1 Project part: XC7K7Otbg676-2
v
Libraries  Compile Order WCHISEIEEE  EE
~  METLIST AMALYSIS Target language: VHDL
> Open Synthesized Design Properties ?2 00 X Simulator language: Wixed
~  IMPLEMENTATION ﬁ
Implementation
P Run Implementation
en Implarmented Masia Status: Mot started
»  OpenlImplemented Design ctto see properties )
Messages: Mo errors or warnings
~ PROGRAM AND DEBUG { e poTLEatEe R "B
¥ Generate Bitstream
TclConsole | Messages | Log | Reports | DesignRuns X ? 006G
> Open Hardware Manager
Q = £ + %
Name Constraints ~ Status WHE  TNS WHS THS TPWS TofalPower FailedRoutes LUT FF  BRAMs URAM f
impl_1  constrs_2 Not started
< bd

Using Constraints

Figure 7: Project Default View
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Step 2: Defining Constraint Sets and Files

Start by creating a new constraint set and adding an empty XDC constraints file to it. The example
design already contains two constraint sets, but you do not use them for this lab.

1. From the Flow Navigator, click Add Sources in the Project Manager section.
2. From the Add Sources dialog box, select Add or create constraints.

3. Click Next.
4

From the Add or Create Constraints dialog box, use the Specify Constraint Set drop-down menu to
select Create Constraint Set as shown in the following figure.

Specify constraint set: | = constrs_2 (active vl
+ | i constrs_1
4 @ constrs_2 (active

Constraint File  LOCE 4 oo ate Constraint Set..

5 top_fullxde  C:\Wivaoo_ Tutonanproje sl cpu_nemsnproject.

Figure 8: Create Constraint Set Drop-Down Menu

5. In the Create Constraint Set dialog box, specify the constraint set name as 1ab1 and click OK.

S

Enable the Make active check box.

Click the Add button T and select Create File to add a new XDC file to the project.

~

8. The Create Constraints File dialog box appears.

Create Constraints File

Create a new constraints file and add it to your

project
File type: & XDC w
File name: || |
File location: | &9 <Local to Project= hd

.’I_.\.
R

Figure 9: Create Constraints File Dialog Box

9. Type timing as the file name, and leave the file location set to <Local to Project>.
10. Click OK.

The timing.xdc file is added to the 1abl constraint set.
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11. Click Finish to complete the creation of the new constraint set and XDC file.

You should see the new constraint set and XDC file in the Sources window, as shown in the
following figure. The constraint set is made active, as you directed when you created it.

12. In the Sources window (shown in the following figure), right-click timing.xdc and select Set as
Target Constraint File.

This sets the timing. xdc file as the target XDC file. All constraints added to the design are saved
in the target XDC file.

Sources X 7T 00
Q = & + 2 &

> Design Sources (1
A Constraints (3
A lab1 (1) (active

{4 timing.xdc (target)

w

constrs_2 (1

s

canstrs_1 (1
A Simulation-Cnly Sources (1

> sim_1101

Libraries = Compile Order

Figure 10: Sources Window

Step 3: Creating Timing Constraints

In this step, you will open the synthesized design and use the Vivado® Timing Constraints wizard. The
Timing Constraints wizard analyzes the gate level netlist and finds missing constraints. Use the Timing
Constraints wizard to generate constraints for this design.

1. From the Flow Navigator, click Open Synthesized Design.

2. When the synthesized design opens, click Constraints Wizard under the Synthesized Design
section.

The introduction page of the Timing Constraints wizard appears. This page describes the types of
constraints that the wizard creates: Clocks, Input and Output Ports, and Clock Domain Crossings.

3. After reading the page, click Next to continue.

The Primary Clocks page of the Timing Constraints wizard displays all the clock sources with a
missing clock definition. For this design, the wizard detected five missing clock constraints that are
needed to time logical paths, and four missing clock constraints that are only needed to verify pulse
width and minimum or maximum period requirements.
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Recommended Constraints

Q w 2 u

v Object Mame Frequency (MHz) Period(ns) RiseAt(ns) FallAt(ns) Jitter (ns)
Y [Ul TXOUTCLK mgtEngine/R.. XOUTCLK_QUT undefined undefined

Y Ul TXOUTCLK mgtEngine/R.. XOUTCLE_QUT undefined undefined

J [l THOUTCLK magtEngine/R.. XOUTCLK_OUT undefined undefined

Y| Ul TXoUTCLK mgtEngine/R.. XOUTCLK_OUT undefined undefined

< [ sysClk sysClk undefined undefined

Constraints for Pulse Width Check Only

Q W an

Fl

Object Name Frequency (MHz) Period (ns) Rise At(ns) FallAt(ns) Jitter(ns)

Figure 11: Clock Sources with Missing Clock Definitions

You will fill in the periods for the five missing primary clocks in the design. The second category of
clocks, shown in the Constraints for Pulse Width Check Only table, is optional. For this example, do
not add these last constraints.

4. In the Recommended Constraints table, each row of the wizard is a missing constraint. To specify a
constraint in the table, click the cell in the period column for the clock and type the value from
Table 1 to fill in the periods of the five missing primary clocks in the design. When you set the
period for a clock, the frequency is automatically populated.
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Table 1: Values to Use on the Primary Clock Page of the Wizard

Lab 1: Defining Timing Constraints and Exceptions

Primary Clock Period (ns)
mgtEngine/ROCKETIO_WRAPPER _i/gt0_ROCKETIO_WRAPPER _TILE_i/GTO_TXOUTCLK_OUT 12.8
mgtEngine/ROCKETIO_WRAPPER_i/gt0_ROCKETIO_WRAPPER_TILE_i/GT2_TXOUTCLK_OUT 12.8
mgtEngine/ROCKETIO_WRAPPER_i/gt0_ROCKETIO_WRAPPER_TILE_i/GT4_TXOUTCLK_OUT 12.8
mgtEngine/ROCKETIO_WRAPPER_i/gt0_ROCKETIO_WRAPPER_TILE_i/GT6_TXOUTCLK_OUT 12.8
sysClk 10.0

If you do not want to enter a constraint for a specific clock, uncheck the box next to the clock.

For more information about how the wizard finds these missing constraints, click the Quick Help
button (“?") in the lower left-hand corner of the wizard. The quick help pages are context specific
and contain more information about the topologies the wizard is looking for and an explanation as

to why the constraint is being suggested.

The completed page looks like the following figure.

Timing Constraints Wizard

Primary Clocks

Primary clocks usually enter the design though input ports. Specify the period and optionally a name and waveform (rising and falling edge times) to describe
the duty cycle if not 50%. More info

Recommended Constraints

Q w 2

¥ Object MName Frequency (MHz) Period (ng) Rise At(ns) FallAt{ns) Jitter (ns)
i} TXOUTCLK:I matEngine/ROCKE... TO_TXOUTCLK_OUT 78.125 12.800 0.000 6.400

< Ul TXouTcLK mgtEngine/ROCKE...T2_TXOUTCLK_OUT 78125 12800 0.000 5.400

< I TXOUTCLK mgtEngine/ROCKE.. T4_TXOUTCLK_QUT 78.125 12.800 0.000 5.400

< Ul TXouTcLK mgtEngine/ROCKE..T6_TXOUTCLK_OUT 78.125 12.800 0.000 5.400

< I sysClk sysClk 100.000 10.000 0.000 5.000

Constraints for Pulse Width Check Only

Q W Ly

4

Object Name Frequency (MHz) Period (ns) Rise At(ns) FallAt(ns) Jitter (ns)

TclCommand Preview {5)  Existing Create Clock Constraints (0)

Q

p

[create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gtd_ROCKETIO_WRAPPER_TILE_I/GT0_TXOUTCLK_OUT -waveform {0.000 6

create_clock -period 12 800 -name mglEngine/ROCKETIO_WRAPPER_TILE _ilgt2_ROCKETIO_WRAPPER_TILE_i/GT2_ X

create_clock -period 12 §00 -name mgtEngine/ROCKETIO_WRAPPER_TILE _ilgtd_ROCKETIO_WRAPPER_TILE_i/GT4_ &
create_clock -period 10.000 -name sysClk -waveform {0.000 5.000} [get_ports {sysClk}]
<

TAOUTCLK_OUT -waveform {0.000 &
GT4_THXOUTCLK_OUT -waveform {0.000 &
create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gt6_ROCKETIO_WRAPPER_TILE_I/GTE_TXOUTCLK_QUT -waveform {0.000 &

w

»

| Cancel

Figure 12: Completed Primary Clocks Page of the Timing Constraints Wizard
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5. Click Next to continue.

The primary clock constraints have been added to the design. Next, the wizard looks for
unconstrained generated clocks. Generated clocks are derived from primary clocks in the FPGA
fabric. A good example would be a binary counter used to create a divided clock.

In this design, the wizard determined that there are no unconstrained generated clocks.
6. Click Next to continue.

Next, the wizard looks for forwarded clocks. A forwarded clock is a generated clock on a primary
output port of the FPGA. These are commonly used for source synchronous buses when the capture
clock travels with the data.

The wizard has determined that there are no unconstrained forwarded clocks in the design.
7. Click Next to continue.

Next, the wizard looks for external feedback delays. MMCM or PLL feedback delay outside the FPGA
is used to compute the clock delay compensation in the timing reports.

The wizard did not find any unconstrained MMCM external feedback delays in the design.
8. Click Next to continue.

Next, the wizard looks at the input delays. The following figure shows the Input Delay page of the
Timing Constraints wizard. There are three sections to the page.
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Timing Constraints V

Input Delays

Input delays describe relative phase between reference clocks (usually board clocks) and input signals at the FPGA boundary. Inaccurate input delay values can make timing fail and ’
affect implementation quality of results. More info

Recommended Constraints

[ - | nor, Delay Parameters
Vv Interface Clock Synchronous  ~ ' Alignment ~? DataRate and Edge ~2 Clock period: 10 ns
" i = o | = ; - ~

[# Dataln_pad_0_i[ I sysCik System Edge Single Rise 2 undefined | ns
+| [ Dataln_pad_1_i[*] U1 sysClk System ~  Edge ~  Single Rise w
¥ @ LneState..ad 0 7] [l sysCik System v Edge +~  Single Rise v too_max: undefined | ns
| [ LineState._.ad_1_i[*] T sysClk System ~  Edge ~  Single Rise hd tree_dly_min: undefined | ns
¥ & VStatus_pad_0_i*] U sysClk System ~  Edge ~  Single Rise v

) ) tree_dly_max: undefined | ns
v B vstatus_pad_1_i[ TN syscik System v Edge ~  Single Rise v
+ [Er GTPRESET_IN MMm.T System ~  Edge “  8ingle Rise s
| [E GTPRESET_IN Mm.T System “  Edge “  Single Rise b
| [Er GTPRESET_IN Mmm.T System ~  Edge *  Single Rise w
| [@ GTPRESET_IN MMm.T System ~  Edge ~  Single Rise w Rige Max = tco_max + tree_dly_max
Rise Min =tco_min +tree_dly_min
| B RxActive_pad_0_i U1 sysCik System v Edge ~  gingle Rise ~
| Er RActive_pad_1_i TN sysClk System ~  Edge *  Single Rise w
+| B RxError_pad_0_i U sysClk System ~  Edge “  Single Rise b ApBlY
F B e e 4z An _...~u. . - ———— - et i o o~ —

Tcl Command Preview {49) Existing Set Input Delay Constraints {0} Waveform - System | Edge | Single Rise

input dock / \ C / \
2 YXXXXXXX o XQO0XK

T
———— (tco_min + trce;_dly_min)
!

» (tco_max + trece_dly_max)

| Cancel

Figure 13: Input Delay Page of Timing Constraints Wizard Showing the Major Sections

In section A, you can see all the input ports that are missing input delay constraints in the design. In
this table, you select the timing template you would like to use to constrain the input.

In section B, you provide the delay values for the template. This section will change depending on
the template chosen in section A.

In section C, there are three tabs:

o Tcl Command Preview previews the Tcl commands that will be used to constrain the
design.

o Existing Set Input Delay Constraints shows input delay constraints that exist in the design.

o Waveform displays the waveform associated with the template.

Using Constraints www.xilinx.com | Send Feedback | 19
UG945 (v2018.3) December 5, 2018


http://www.xilinx.com/
https://www.xilinx.com/about/feedback.html?docType=Tutorials&docId=UG945&Title=Vivado%20Design%20Suite%20Tutorial%3A%20Using%20Constraints&releaseVersion=2018.3&docPage=19

v
(A XI LI NX Lab 1: Defining Timing Constraints and Exceptions

Next, you will fill out the form based on Table 2.

1.
2.

Click the Clock column header to sort the table alphabetically by clock name.

Select the template in section A, enter the values in section B, and observe the Tcl commands,
existing input delays, and the template specific waveform in section C.

Skip entering the first four constraints shown in Table 2 by unchecking the box to the left of the
constraint. In this particular case, you false path these paths from the GTPRESET_IN port later, as it is
an asynchronous reset signal synchronized inside the design.

The blocks of colored rows in Table 2 can all be entered at the same time in the Input Delays page
of the Timing Constraints wizard, shown in Figure 14, page 21, by selecting multiple rows in the
wizard (use the Shift or Ctrl buttons and click to select multiple rows) and then entering the values
once. Some inputs are constrained relative to virtual clocks, since they are captured by an internal
generated clock with a waveform different than the board clock. In this case, the wizard creates a
virtual clock with the same frequency and waveform as the internal clock, and recommends a
constraint relative to the virtual clock.

Table 2 is shaded to indicate which groups of signals can be entered in this manner.

Table 2: Input Constraint Values

Interface Clock Synchronous | Alignment Data Rate tco_min | tco_max | trce_dly_min trce_dly_max
and Edge (ns) (ns) (ns) (ns)
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
GTPRESET_IN mgtEngine/... System Edge Single Rise Uncheck constraint — will false path later
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3. The following figure shows the completed input delay page. Note the four constraints being

Lab 1: Defining Timing Constraints and Exceptions

skipped.

Timing Constraints Wizard

Input Delays
Input delays describe relative phase between reference clocks (usually board clocks) and input signals at the FPGA boundary. Inaccurate input delay values can make timing fail and ‘
affectimplementation quality of results. More info
Recommended Constraints
(oI~ - | mow, Delay Parameters
= Interface Clock ~ 1 Synchronous Alignment Data Rate and Edge Clock period 10 ns
System single Rise -
. tco_min: 1 ns
System Single Rise
System Single Rise tco_max 2 Bs
System single Rise tree._dly_min: q ns
~| | B Dataln_pad_0_i[*] ﬂﬂ sysClk System ~  Edge *  B8ingle Rise hd
- ) ) trce_dly_max: 1 ns
/| B Dataln_pad_1_i[* U1 sysClk System ~  Edge ~  Single Rise ~
7| B LineState..ad_0_i[*] U1 sysClk System ~  Edge ~  Single Rise w
| B LineState..ad_1_i[*] I sysClk System ~  Edge “  Single Rise A4 3 5
v B VStatus_pad_0_i[*] I sysClk System ~  Edge “  Single Rise A4
v B vStatus_pad_1_i[] I sysCik System ~  Edge “  Single Rise - Rise Max =tco_max + tree_dly_max
Rise Min =tco_min + trce_dly_min
+| D ReActive_pad_0_] 1N sysCik System «~  Edge “  Single Rise v
+| D ReActive_pad_1_] 1N sysCik System «~  Edge “  Single Rise v
~|  [Cr RxError_pad_0_i TN sysCik System w  Edge ~  8ingle Rise hd -
5 Lo N ) an -...~ue PRSP P ———— . P Tp F- P ~ ﬁpply
Tcl Command Preview {41)  Existing Set Input Delay Constraints (0) | \Waveform - System | Edge | Single Rise
set_input_delay -clock [get_clocks {sysCIk}] -min -add_delay 2.0 [get_ports {Dataln_pad_0_i[*I}] E
set_input_delay -clock [get_clocks {sysClk}] -max -add_delay 3.0 [get_ports {Dataln_pad_0_i[*T}]
set_input_delay -clock [get_clocks {sysCIk}] -min -add_delay 2.0 [get_ports {Dataln_pad_1_i[}}]
set_input_delay -clock [get_clocks {sysCIk}] -max -add_delay 3.0 [get_ports {Dataln_pad_1_i[*[}]
set_input_delay -clock [get_clocks {sysCIK}] -min -add_delay 2.0 [get_ports {LineState_pad_0_i[*}]
set_input_delay -clock [get_clocks {sysCIk}] -max -add_delay 3.0 [get_ports {LineState_pad_0_i[*]}]
set_input_delay -clock [get_clocks {sysClk}] -min -add_delay 2.0 [get_ports {LineState_pad_1_i[*l}
set_input_delay -clock [get_clocks {sysClk}] -max -add_delay 3.0 [get_ports {LineState_pad_1_i[*T}] ~

Figure 14: Completed Inputs Page of the Timing Constraints Wizard

When you have successfully entered all the input constraint values, click Next.

The Output Delays page of the wizard displays all the outputs that are unconstrained in the design.
The page layout is very similar to the inputs page.

5. In the Output Delays page, click the Clock header to sort the table alphabetically by clock name.

6. Use Table 3 below to constrain all the outputs as you did for the input constraint values. You can
select multiple lines in the wizard at once and edit several entries at the same time.
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Table 3: Output Constraint Values

Interface Clock Synchronous | Alignment Data Rate tsu thd trce_dly_max | trce_dly_min
and Edge (ns) (ns) (ns) (ns)

7.

10.

11.

Click Next to continue.

The wizard looks for any unconstrained combinational paths through the design. A combinational
path is a path that traverses the FPGA without being captured by any sequential elements. This
design does not contain any combinational paths.

Click Next to continue.

Physically exclusive clock groups are clocks that do not exist in the design at the same time. There
are no unconstrained physically exclusive clock groups in this design.

Click Next to continue.

Logically exclusive clocks with no interaction are clocks that are active at the same time except on
shared clock tree sections. Then these clocks do not have logical paths between each other and
outside the shared sections, they are logically exclusive. There are no unconstrained logically
exclusive clock groups with no interaction in the design.

Click Next to continue.

Logically exclusive clocks with interaction are clocks that are active at the same time except on
shared clock tree sections. When these clocks have logical paths between each other, only the
clocks limited to the shared clock tree sections are logically exclusive and are therefore constrained
differently than the logically exclusive clock with no interaction. There are no unconstrained logically
exclusive clock groups with interaction in the design.

Click Next to continue.
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The Asynchronous Clock Domain Crossings page recommends constraints for safe clock domain
crossings. This design does not contain any unconstrained clock domain crossings.

12. Click Next to continue.

The following figure shows the final page of the Timing Constraints wizard. All the constraints that
were generated by the wizard can be viewed by clicking the links. If you would like to run any
reports once the wizard is finished, you can select them using the check boxes in the wizard.

Timing Constraints Wizard

Constraints Summary

VIVADO'

Hix Editione o The Timing Constraints Wizard created 83 new timing constraints:

Create Clock (7)
Set Input Delay (38)
Set Output Delay (38)

On Finish
View Timing Constraints
Create Timing Summary report
Create Check Timing report

Create DRC report using only timing checks

v
i‘ XI LINX To keep the new constraints and perform the selected actions, click Finish. The new constraints will automatically be saved to
ALL PROGRAMMABLE. your target XDC file. To discard the constraints, click Cancel.

Figure 15: Timing Constraints Wizard Summary Page

13. Click Finish to complete the Timing Constraints wizard.
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Step 4: Using the Constraints Editor

1. Click Edit Timing Constraints from the Flow Navigator under the Synthesized Design section. The
Vivado IDE displays the Timing Constraints window.

Project Summary x| Device = | Timing Constraints x [ ]
= & r -|-‘ =+ Create Clock
= Clocks (7) ~ Position  Clock Name Period (ns) Rise At(ns) FallAt(ns) AddClock Source Objects
Create Clock (7} 1 mgtEngine/ROCKETIO_WRAP... 12.800 0.000 6.400 [get_pins mgtEngine/ROCKETIO_|
Create Generated Clock (0} 2 mgtEngine/ROCKETIO_WRAP... 12.800 0.000 6.400 [get_pins mgtEngine/ROCKETIO_|
Rename Auto-Derived Clock (0) 3 mgtEngine/ROCKETIO_WRAP 12.800 0.000 6.400 [get_pins mgtEngine/ROCKETIO_
Set Clock Latency (0) 4 motEngine/ROCKETIO_WRAP... 12.800 0.000 6.400 [get_pins matEngine/ROCKETIO_|
Set Clock Uncertainty (0) 5 sysClk 10.000 0.000 5.000 lget_ports sysClk]
Set Clock Groups (0) g VIRTUAL_cpuClk_5 20.000 0.000 10.000
Set Clock Sense (0) 45 VIRTUAL_whClk_4 20.000 0.000 10.000

Set Input Jitter (0) Double click to create a Create Clock constraint

Set System Jitter (0)

Set External Delay (0)
~ Inputs (28)

SetInput Delay (38) | I &

All Constraints

Q = £ @ 7T,
Position Command Scoped Cell
~ [ timing.xdc (C:Mivado_Tutorial/project_cpu_netlistiproject_cpu_netlist sresilab1inewtiming xdc)
1 create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gtd_ROCKETIO_WRAPPE...
create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gt2_ROCKETIO_WRAPPE...

create_clock -period 12.800 -name mgiEngine/ROCKETIO_WRAPPER_TILE_i/gté_ ROCKETIO_WRAFPPE...
create_clock -period 10.000 -name sysClk -waveform {0.000 5.000} [get_ports sysCIk]
create_clock -period 20.000 -name VIRTUAL_cpuClk_5 -waveform {0.000 10.000}

create_clock -period 12.800 -name mgtEngine/ROCKETIO_WRAPPER_TILE_i/gt4_ROCKETIO_WRAPPE... C

set_input_delay -clock [get_clocks sysClk] -min -add_delay 2.0 [get_ports {Dataln_pad_0_i[*}]
set_input_delay -clock [get_clocks sysClIk] -max -add_delay 3.0 [get_ports {Dataln_pad_0_i[*T}]

W o = m o B w h

set_input_delay -clock [get_clocks sysClk]-min -add_delay 2.0 [get_ports {Dataln_pad_1_i[*[}] o

Figure 16: Timing Constraints Window

There are three sections to the Timing Constraints window, as shown in the following figure:

o Constraints tree view is labeled as section “A.” This section displays standard timing
constraints, grouped by category. Double-clicking a constraint in this section opens a form
to help you define the selected constraint.

o Constraints Spreadsheet is labeled as section "B.” This section displays timing constraints of
the type currently selected in the Constraints tree view. If you prefer, you can use this to
directly define or edit constraints instead of using the Constraints wizard.

o All Constraints is labeled as section “C.” This section displays all the timing constraints that
currently exist in the design.
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The Timing Constraints wizard identifies missing clocks, 1/0 delays, and clock domain crossings
exceptions, but it does not handle general timing exceptions. You are going to use the timing
constraints editor to create the exceptions that exist in this design.

First, you are going to set a false path on the GTPRESET IN input. This is the input constraint that
you skipped by unchecking it on the input delay page of the Timing Constraints wizard. The
GTPRESET_IN signal is an asynchronous reset that is properly synchronized inside the design. For
more information about false paths, see this link in the Vivado Design Suite User Guide: Using
Constraints (UG903).

2. In the Constraints tree view, scroll down to the Exceptions category, shown in the following figure.

3. Double-click Set False Path.

Timing Constraints

|2 » +‘ i 4 Set False Path
- 3
Set Qutput Delay (38 #  Position  Setup/Hold  Rise/Fall  Reset Path start Foints Transition (5t
~ Assertions (O Doukble click to create a Set False Path constraint

Set Data Check (C
Set Bus Skew (C
~ Exceptions (C
Set False Path (0)
Set Multicycle Path (O
Set Maximum Delay (0
58t Minimum Delay (-
~ Others (0
Set Case Analysis (O

Figure 17: Set False Path Section in the Constraints Editor
4. To the right of the From text box, click the Choose Start Points l—l button.
The Specify Start Points dialog box appears.
5. From the Find names of type drop-down list, select /0O Ports as shown in Figure 18, page 26.

6. Under Options, select “Name,

7. Click the Find button.

contains,” and in the search pattern text box, enter GTPRESET _IN.
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8. Select GTPRESET_IN in the found results text box and press the right arrow to move it to the

selected names text box.

o TIP: You can also double-click GTPRESET_IN to move it from the Find results list to

the Selected names list.

Notice that the Command field displayed at the bottom of the dialog box changes as you perform

these different actions. The get ports command changes to:

get ports "*GTPRESET IN*"

Specify Start Points

Specify a list of path endpoints or clocks.

Find names oftype: | /O Ports w
Options
NAME iV

containg W GTPRESET_IN

Regular expression

Ll
+

1+
+

Enumerate

QOf Objects:
Results
Found: 0 Selected: 1
GTPRESET_IN
= _
Use the buttons on the right to move items =
to this list.
—-
—
—
=
Command: aget_pors “GTPRESET_IN*"
(?) Set

| | Append ‘ | Cancel

Figure 18: Choose Start Points Window for set_false_path Dialog Box
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9. Click Set in the Specify Start Points dialog box.

The completed Set False Path dialog box is shown in the following figure. Notice the following

command text in the Command field at the bottom of the dialog box:

set false path -from [get ports "*GTPRESET IN*"]

The Vivado IDE displays the Tcl command form of all constraints created via the dialogs for your
review. This is useful for learning the Tcl command syntax, and for verifying the final constraint

before adding it.

Set False Path x

Define falze paths in the design that are not considered during timing analysis.

End Points

Command: set false_path -from [get_ports =GTPRESET_IN*T]

g
Targets Options
Start Points

Erom: | [get_ports ™GTPRESET_IN* ETransition riseffall w
Through Points

Through: E risefall +

To: IZ‘ risesfall

Reference ‘ ‘ Resetto Defaults

Figure 19: Completed set_false_path Constraint Window
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10. Click OK to close the Timing Constraint Editor.

Vivado creates the false path exception.

Add a MultiCycle Path

Next, you will add a multicycle path using the constraints editor.
1. Double-click on Set Multicycle Path under the Exceptions category of the tree.
2. In the Set Multicycle Path dialog box, set the path multiplier to 2.

3. In the Through entry box, type the following string (alternately, you can copy and paste it from
here):
[get pins cpuEngine/or1200 cpu/orl1200 alu/*]
Notice that the Tcl command displays in the Command field.

4. Click OK.

A new multicycle path is added to the constraints editor in the <unsaved_constraints> section, as

shown in the following figure.

oject Summary x | Device » | Timing Constraints x b I I ]
= £ F + : + =/ SetMulticyde Path
Set Qutput Delay (35 #  Position  Path Multiplier ~ Setup/Hold  RisefFall  Start/End  Reset Path start Foints Transition (5tart) Through Poit
~ Assertions (0 85 zZ ~through [get_pir
Set Data Check (0 Double click to create a Set Multicycle Path constraint

Set Bus Skaw (C
~ Exceptions (2
Set False Path (1
Set Multicycle Path (1)
Sat Maximum Delay (0
Set Minimum Delay (¢
~ Others (0
Set Case Analysis (0
Group Path (C
Set Disable Timing (0 v £ >

All Constraints
Q 2l ¥ o =0

Paosition Command

75 set_output_delay -clock [get_clocks sysCIK] -max -add_delay 1.1 [get_ports VControl_Load_pad_1_o] N
76 set_output_delay -clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports Xovselect_pad _0_o]
77 set_output_delay -clock [get_clocks sysClk] -max -add_delay 1.1 [get_ports Xovielect_pad_0_o]
78 set_output_delay —clock [get_clocks sysCIk] -min -add_delay 0.0 [get_ports Xovselect_pad_1_0]
79 set_output_delay -clock [get_clocks sysCIK] -max -add_delay 1.1 [get_ports Xovselect_pad_1_o]
80 set_output_delay -clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports phy_rst_pad_0_o]
21 set_output_delay —clock [get_clocks sysClk] -max -add_delay 1.1 [get_ports phy_rst_pad_0_o]
82 set_output_delay —clock [get_clocks sysCIk] -min -add_delay 0.0 [get_ports phy_rst_pad_1_o]
83 set_output_delay -clock [get_clocks sysClk] -max -add_delay 1.1 [get_ports phy_rst_pad_1_o]
W <unsaved constraints >
g4 set_false_path -from [get_ports "CTPRESET _INT]
85 set_multicycle_path -through [get_pins cpuEngine/orl200_cpu/orl200_alu/*] 2 o
< >
Figure 20: New Multicycle Path Added to the Constraints Editor
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Adding a multicycle path by default pushes the setup timing to the specified number of cycles (N),
but it also pushes the hold timing to N — 1 cycles. This is usually not what is intended and could cause
Vivado tools to spend a lot of time fixing large hold violations. In this case we want the setup path
to be timed to two cycles of the clock, but we want the hold path to be timed to zero cycles of the
clock. To achieve this, we need to define another multicycle path on the hold edge to 1, such that

N — 1 is zero. For more information about this situation, see this link in the Vivado Design Suite User
Guide: Using Constraints (UG903).

5. Double-click Set Multicycle Path under the Exceptions category of the tree for a second time.
Note that all the fields you entered previously are still filled in.

In the Set Multicycle Path dialog box, change the Path Multiplier to 1.

Select the Options tab.

Under Setup/Hold, select the check box that says Use path multiplier.

L ©o N o

Use the pull-down to select hold (minimum delay).

Set Multicycle Path

Define multicycle path. This command allows specifying the total number of clock cycle required for propagation of a
signal from its origin to destination when that propagation is longer than a single clock cycle. ‘

Specify path multiplier: 1

LI

Targets Options

Setup/Hold

+ Use path multiplier for | hold (minimum delay) ~ | calculation

Rise/Fall

Use path multiplier for endpoint | rising delays

Start/End

Multicycle information is relative to the | startpoint clock

Remove existing path exceptions before setting multicycle path

Command: set_multicycle_path -hold -through [get_pins cpuEngine/or1200_cpuw/or1200_aluf] 1
Reference ‘ ‘ Resetto Defaulis

Figure 21: Set Multicycle Path — Options Tab

10. Click OK.
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We now have a fully constrained design in memory. To save the constraints to disk, proceed to Step 5:
Saving Constraints.

Step 5: Saving Constraints

Constraint management is an important step of the design flow, and the Vivado Design Suite provides
you the flexibility of adding new constraints into an existing constraint file, overwriting existing
constraints, or creating a new constraints file to track design changes or complete missing constraints.

You have created a few timing exceptions for the design, but the exceptions exist only in memory and
not on disk yet. You need to save the exceptions to the timing. xdc file.

1.
2.

From the Sources window in Vivado, double-click timing.xdc under Constraints > lab1.

Scroll to the bottom of the file and notice that the set false path and
set multicycle path constraints do not exist in the file. This is also reflected in the Timing
Constraints Editor as <unsaved constraints>, as shown in the following figure.

All Constraints

Q T ¢ @ ¥
Position Command Scoped Cell
79 set_output_delay -clock [get_clocks sysClk] -max -add_delay 1.1 [get_ports XovSelect_pad_1_o] -
80 set_output_delay -clock [get_clocks sysClk] -min -add_delay 0.0 [get_ports phy_rst_pad_0_o]
81 set_output_delay -clock [get_clocks sysClk] -max -add_delay 1.1 [get_ports phy_rst_pad_0_qa]
a2 set_output_delay -clock [get_clocks sysClk]-min -add_delay 0.0 [get_ports phy_rst_pad_1_o]
83 set_output_delay -clock [get_clocks sysClk] -max -add_delay 1.1 [get_ports phy_rst_pad_1_0o]
w =unsaved constraints=
84 set_false_path -from [get_ports *GTPRESET_IN*]
a5 set_multicycle_path -through [get_pins cpuEngine/or1200_cpufor1200_alu/] 2
86 set_multicycle_path -hold -through [get_pins cpuEnginefor1200_cpufor1200_alu/] 1 -

Figure 22: Unsaved Constraints Displayed in the Constraints Editor.

1
Click the Save Constraints button H or use the File > Constraints > Save As command from the
main menu.
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4. Click the Reload link in the banner of the timing.xdc tab to reload the constraints file from disk.
Notice that the false path and multi-cycle paths are now visible in the timing.xdc text file, as

shown in the followi

Project Summary % | t

Q

set output delay
set_output_delay
set _output delay
set_output_delay
set_output_delay
set_output delay
set_output_delay
set_output_delay
set_output delay
set_output_delay
set_output_delay
set output delay
set_output_delay
set_output_delay
set output delay
set_output_delay
set _output delay
set_output_delay
set_output_delay
set_output delay
set_output_delay
set_output_delay
set_output delay
set_output_delay
set_output_delay
set output delay
set_output_delay
set _output delay
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iming.xde %

& B B X N/ E

-clock [get_clocks
-clock [get_clocks
-clock [get clocks
-clack [get_clocks
-clock [get_clecks
-clock [get clocks
-clack [get_clocks
-clock [get_clocks
-clock [get clocks
-clock [get_clocks
-clock [get_clocks
-clock [get_clocks
-clock [get_clocks
-clock [get_clocks
-clack [get_clocks
-clock [get_clecks
-clock [get clocks
-clack [get_clocks
-clock [get_clecks
-clock [get clocks
-clack [get_clocks
-clock [get_clocks
-clock [get clocks
-clock [get_clocks
-clock [get_clocks
-clack [get_clocks
-clock [get_clecks
-clock [get clocks
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-min -add_delay 0.000 [get ports [VControl pad 1 o[*]}]
-max -add_delay 1.100 [get ports {VControl pad_l o[*]}]

-min
—-max
-min
—max
-min
—max
-min
-max
-min
—max
-min
—max
-min
—max
-min
—-max
-min
—max
-min
—max
-min
-max
-min
—max

set false path -from [get ports *GTPRESET_IN*]
set_multicycle path -through [get_pins cpuEngine/orlZ00_cpu/orl200_alu/*] 2
set multicycle path -hold -through [get pins cpuEngine/orlZ00_cpu/orlZ00_alu/*] 1

-add_delay 0 [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add delay [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add delay [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add delay [get_ports
-add_delay [get_ports
—add_delay [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add delay [get_ports
-add_delay [get_ports
-add_delay [get_ports
-add delay [get_ports
-add_delay [get_ports
—add_delay [get_ports
-add_delay [get_ports
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SuspendM pad 0_o]
SuspendMd pad 0_o]
Suspendd_pad 1_o]
SuspendM pad 1 o]
TermSel_pad 0_o]
TermSel_pad 0_co]
TermSel pad 1 o]
TermSel_pad_1_o]
TxValid_pad 0_co]
TxValid pad 0 o]
TxValid_pad 1_o]
TxValid pad 1_o]
WVControl Load pad 0_o]
WVControl_Load_pad 0_o]
VControl_Load pad 1 o]
WVControl Load pad 1 o]
Hovielect_pad_0_o]
XcvSelect pad 0_o]
Hcv3elect_pad_l1_o]
HevSelect_pad_1_o]
phy_rst pad 0 o]
phy_rst_pad 0_o]
phy_rat_pad 1_o]
phy_rst_pad 1 o]

Figure 23: timing.xdc Tab
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Step 6: Clock Interaction Report

After or during constraints creation, you must verify that the constraints are complete and safe. Vivado
Design Suite times all clocks together by default unless you specify otherwise by defining clock groups
or other timing exceptions. The set clock groups command specifies asynchronous or exclusive
clock domains and disables timing analysis between them. You can also use the set false path
exception between two clocks to disable timing on all paths between them, or use it on specific netlist
objects to only disable some paths. The set multicycle path exception modifies the clock edges
used during timing analysis instead of the default single cycle assumption. For more information on
using these constraints, see the Vivado Design Suite User Guide: Using Constraints (UG903).

Vivado automatically infers timing path requirements for paths that cross between two different clock
domains, called inter-clock paths, making assumptions regarding phase and offset. The Report Clock
Interaction command reports inter-clock paths, to help identify potential problems such as unrealistic
setup or hold requirements between two clocks, or unsafe timing between asynchronous clocks (no
known phase relationship) which can lead to unstable hardware behavior.

1. From the Flow Navigator, select Synthesized Design > Report Clock Interaction and click OK in
the Report Clock Interaction dialog box to accept the default settings.

Project Summary % Device x Timing Constraints x ftiming.xdc x| Clock Interaction -timing_1  x 200

Q e @ M C e

Destination Clocks

T, o oy
Pucy ", Loy, Yoty Loy, Lo, Wiy B Wy

Yoy

pUCIK_5
CIk_0
R_TILE_IGTO_TXOUTCLK_OUT
R_TILE_i/GT2_TXOUTCLK_OUT
R_TILE_iGT4_TXOUTCLK_OUT
R_TILE_UGT6_TXOUTCLK_OUT
phyClko_2

phyCIk1_1

sysClk

ushClk_3

VIRTUAL_cpucClk_5

WwhClk_4

Source Clocks:

W NoPath B Timed [ Partial False Path [ Max Delay Datapath Only
B Userlgnored Paths W Timed (unsafe) [0 Partial False Path (unsafe)
6o s oemmmcox A NS 1S famen pmoeew cms Sme o we we cwemewn oo e oo seos
1 VIRTUAL_cpuClk_5 wbClk_4 rise - rise 13060 0.000 0 176 20.000 rise -rise 1201 0.000 0 176 0.000 \Virtual Clock Timed
2 VIRTUAL cpuClik_5 cpuCli_5 rise - rise 11.605  0.000 0 834 20.000 rise -rise 1.209 0.000 0 834 0.000 Virtual Clock Timed
3 MmCliC_0 Clk_0 rige -rise 7.255 0.000 0 8352 10.000 rise -rise 0.041 0.000 0 8352 0.000 Clean Timed
4 fRCIk_0 whClk_4 rise-rise 7.788 0.000 0 72 10.000 rise-rise -0.057 -0.057 1 72 0.000 Clean Timed
5 MCIk_0 cpuClk_5 rise - rise 6433 0000 0 61 10.000 rise -rise 0443 0.000 0 61 0000 Clean Timed
6 phyClk1_1 phyClk1_1 rise - rise 5114  0.000 0 5958 10.000  rise -rise 0.000 0.000 0 5958 0.000 Clean Timed
7kt 1 nehrlk 3 rica - riza A752 00NN n a7h 00NN | rise.risa 0140 .31 AOA EET) a7h nonn riean Timad

Figure 24: Clock Interaction Report

The Vivado IDE generates a graphical matrix illustrating the relationship of the various clocks in the
design, as shown in the previous figure. For this design, the primary clock (sysClk) connects to an
MMCM, which generates six additional clocks. The clock interactions shown are between these
generated clocks. In addition, the Timing Constraints wizard created additional generated clocks
and virtual clocks to fully constrain the design.
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In general, the Clock Interaction report shows clock pairs with no path between them (black), with
paths safely timed (green and light blue), with paths not safely timed (red and orange) and with
paths covered by Max Delay Datapath Only constraints. In this design, only black cells and green
cells are displayed in the matrix.

Important! Green in the matrix does not mean that timing is met, it simply means
that the timing constraints and the clock tree topologies allows safe timing analysis
and accurate slack computation.

In the Clock Interaction report, unsafe means there is no common primary clock (no known phase
relationship), or no common node (uncommon scenario that results in unknown phase relationship),
or no common clock period within the first 1000 clock cycles of the source and destination clocks.
The Vivado timing engine selects edges on the launch and capture clocks based on the first 1000
cycles, but these edges might not reflect the most pessimistic analysis between the clocks.

O TIP: The colors described here are the default colors. Your colors might be configured
differently from those shown in Figure 24.

2. Close the Clock Interaction window by clicking the Close button * in the window tab.

Step 7: Timing Summary Report

Timing paths start and end at clocked elements. Input and Output ports are not sequential elements,
and by default Vivado timing analysis does not time paths to or from I/O ports in the design, unless
input/output delay constraints are specified.

In this step you will generate and interpret timing reports in Vivado.
1. Select Reports > Timing > Report Timing Summary.
2. Click OK to generate the report, using the default options.

The timing summary tab opens, as shown in the following figure.

Timing
Q = £ C H 0O 4 Design Timing Summary

General Information ""
Timer Settings Setup Hold Pulse Width

@ Design Timing Summary Waorst Negative Slack (WNS): 2,250 ns Worst Hold Slack (WHS): -0.274ns Worst Pulse Width Slack (WPWS) 3.000 ns
Clock Summary (14 Total Negative Slack (TNS):  0.000 ns Total Hold Slack (THS): -372.506 ns Tatal Pulse Width Negative Slack (TPWS):  0.000 ns
Check Timing (2 MNumber of Failing Endpoints: 0 MNumber of Failing Endpoints: 5478 Mumber of Failing Endpoints 0

» Intra-Clock Paths Total Number of Endiaints: 46377 Total Number of Encoints: 45377 Total Number of Endpoints: 16037

« Inter-Clock Paths

Timing constraints are not met.
Qther Path Groups 9

User lgnored Faths

Timing Summary - timing_1

Figure 25: Report Timing Summary Results
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This design passes setup timing but fails hold analysis. Before implementing the design, timing analysis
uses estimated net delays that represent ideal placement. Small hold violations are common at this
point of the flow and will be fixed during the routing step. For now, review the content of the report.

3. Click on the Worst Negative Slack link in the design timing summary section to see the worst
timing path in the design, as shown in the following figure.

ess 5 Log s D g Timing x 2?2 00
Q T =2 CcH O 10 = ¥ ©‘ un Inter- Clock Paths - usbCIk_3 to cpuCIk_5 - Setup
¥ phyClk0_2 to whlk_4 "’ Name Slack “1 Levels Routes High Fanout From To Total Delay Logic Delay Net Delay Requirement
> phyClkl1_1 to cpuClk_5 Path 473 2.250 17 18 165 ushEnginelfudfinta_reg/C  cpuEngine/orl.. .u_err_o_reg/D 7.406 1583 5.823 10.0~
> phyClk1_1 1o sysClk Path 474 2.250 17 18 165 wusbEngineljfu4/inta_rea/C  cpuEngine/orl...g_o_reg[0]/D 7.406 1.583 5.823 10.0
5 lephyClkl_1to ushClk_3 Path 475 2.250 17 18 165 usbEngineljfu4/inta_req/C  cpuEngine/orl g_o_reg[1]/D 7.406 1583 5.823 10.0
> phyClk1_1to whilk_4 Fath 476 2.250 17 18 165 usbEnginelfu4/inta_reg/C  cpuEngine/orl..g_o_reg[3]/D 7.406 1.583 5.823 10.0
> sysClk 1o phyClk0_2 Path 477 2.257 17 18 165 usbEnginel/u4/inta_rea/C  cpuEngine/orl. g_o_reg[2]/D 7.399 1583 5.816 100
» [ sysClk o phyClk1_1 Path 478 2.257 17 18 165 usbEnginelju4fimta_rea/C  cpuEngine/orl..cstb_o_reg/D 7.393 1.583 5.815 10.0
~ o ushClk_2 1o cpucli 5 Path 479 2581 16 17 165 usbEnginel/u4/inta_reg/C  cpuEngine/orl  r_o_reg[13]/D 7.075 1.540 5.535 10.0,,
Setup 2.250 ns (10) v < >

Timing Summary - timing_1

Figure 26: Worst Timing Path in the Design

4. When the worst path is selected, press the F4 key to bring up its schematic. The following figure
shows the worst setup path in the design.

Project Summa x | Device x | Timing Constraints x timing.xdc x | Clock Interaction - timing_1 ¥ Schematic x ?0O0

Q a H B O — & 4Cels 44Nels o

o eyl oo H-{IF g0 0. - =i

Figure 27: Schematic of Worst Setup Path in the Design
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5. In the timing summary tree, select Check Timing.

Lab 1: Defining Timing Constraints and Exceptions

o There are nine issues flagged by Check Timing shown in the following figure.

o Eight of these are pulse width clock checks, which were also flagged by the Timing
Constraints wizard, but were not constrained. These violations have low severity because the
corresponding missing clocks are not needed for timing logic paths.

o The remaining issue flagged by Check Timing is a no _input delay check, which is due to
a missing input constraint on the reset signal that was set to false path. This can also be
ignored in this example.

Tcl Console lessages Log Reports Design Runs Timing »
Q % % C H G Q Check Timing
~ o Check Timing (9) Timing Check Count ~ ' Worst Severity
no_clock (0 pulse_width_clock g OLow
constant_clock (0 no_input_delay 1 Medium
O pulse_width_clock (8 no_clock 0
unconstrained_internal_andpoints (C constant_clock ]
no_input_delay (1 unconstrained_internal_endpoints ]
no_output_delay (0 no_output_delay 0
multiple_clock (0 multiple_clock 0
generated_clocks (0 generated_clocks 0
loops (0 loops 0
artial_input_delay (0
P —nput v partial_input_delay 0
partial_output_delay (0 )
partial_output_delay 0
latch_loops (0
latch_loops 0
» @ Intra-Clock Paths
~ & Inter-Clock Paths -

Timing Summary - timing_1 =

Figure 28: Check Timing Results in the Timing Summary Window
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6. In the timing summary tree, select the Clock Summary, as shown in the following figure. The clock
summary section of the timing summary report lists all the clocks in the design and shows the
resulting frequencies and waveforms of each clock. The hierarchy shows the relationship between
the generated clocks and the primary clock (for example, cpuClk_5 vs. sysClk). For example, it shows
that cpuClk_5 is generated from primary clock SysClk, and its period is twice that of sysClk.

cl Console essages Reports
aQ x %

General Information

Timer Settings

@ Design Timing Summary

>

Clock Summary (14)
Check Timing (9

> @ Intra-Clock Paths
~ Le Inter-Clock Paths

>
>

@ cpuClk_5 to VIRTUAL_wbClk_4
wbClk_4 to VIRTUAL_wbClk_4
phyClk0_2 to sysClk

phyClk1_1to sysClk

usbClk_3 to sysClk

VIRTUAL _cpuClk_5 to cpuClk_5
fiClk_0 to cpuClk_5

> phyClk0_2 to cpuClk_5

Timing Summary - timing_1  x<

v v v v v

Timing  x ?7 00
Q T &
- hd

Name

Clock Summary

Waveform Period (ns)  Frequency (MHz)

VIRTUAL _cpuClk_5
VIRTUAL_wbClk_4
mgteEngine/ROCKETIO_WRAPPER_TILE_iigi0_ROCKETIO_WRAPPER_TILE_I/GTO_TXOUTCLK_OUT
mgtEngine/ROCKETIO_WRAPPER_TILE_ilgt2_ROCKETIO_WRAPPER_TILE_I/GT2_TXOUTCLK_COUT
mgtEngine/ROCKETIO_WRAPPER_TILE_iigtd_ROCKETIO_WRAPPER_TILE_i/GT4_TXOUTCLK_OUT
mgtEngine/ROCKETIO_WRAPPER_TILE_ilgté_ROCKETIO_WRAPPER_TILE_I/GTE_TXOUTCLK_OUT
v sysClk
clkfbout

{0.000 10,000}
{0.000 10,000}
{0.000 6.400}
{0.000 6400}
{0.000 6400}
{0.000 6.400}
{0.000 5.000}
{0.000 5.000}
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12.800
12.800
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12.800
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100.000
100.000

cpuClk_5 {0.000 10.000} 20.000 50.000

fClk_0
phyClko_2
phyClk1_1
usbClk_3
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{0.000 5.000}
{0.000 5.000}
{0.000 5.000}
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10.000
10.000

100.000
100.000
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Figure 29: Clock Summary

The remaining sections of the timing summary report group paths by their type. Each section lists
the top ten paths (specified when the report was generated) in that group. These include inter-clock
paths, intra-clock paths, other path groups, user ignored paths, and unconstrained paths. Clicking
the roots will show a summary of the paths beneath. Expanding the tree further will ultimately
display the top timing paths for each group.

Conclusion

At this point you can either continue to Lab #2: Setting Physical Constraints, or exit the Vivado Design
Suite and continue later. Lab #2 uses the project created during this lab, so be sure not to delete your

work.

In this lab, you learned:

e How to Create a constraint set and set a target constraint file

How to add timing constraints to a design using the Timing Constraints Wizard

How to add timing exceptions using the Timing Constraints Editor

The importance of saving constraints to disk versus in-memory constraints

How to generate the clock interaction report and properly interpret the resulting matrix

How to generate the timing summary report and properly interpret the results
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Lab 2: Setting Physical Constraints

Introduction

In this lab, you will create physical constraints for the CPU Netlist design, observing how actions in the

GUI translate into Tcl commands. Using Tcl commands, complex operations are easily scripted for
repeated use, at various stages of the flow.

Note: If you are continuing from Lab1, and your design is open, skip ahead to Step 2: Adding Placement

Constraints.

Step 1: Opening the Project

This lab continues from the end of Lab #1 in this tutorial. You must complete Lab #1 prior to beginning
Lab #2. If you closed the tool, or closed the tutorial project at the end of Lab #1, you will need to open

them again.

1. Start by loading the Vivado® Integrated Design Environment (IDE) by doing one of the following.

o Launch Vivado IDE from the icon on the Windows desktop.

o Select Windows > Programs > Xilinx Design Tools > Vivado 2018.x > Vivado 2018.x.

o Type vivado from a command terminal.
From the Getting Started screen you can open recent projects.
2. Under Recent Projects, click project_cpu_netlist as shown in the following figure.

VIVADO! £ XILINX

HLx Editions o ALLPROGRAMMABLE.

Qu ick Start Recent Projects

_ project_cpu_netlist
Create Project > C:/Vivado_Tutorial/project_cpu_netlist

Open Example Project >

Manage IP

Open Hardware Manager >

Xilinx Tcl Store

Figure 30: Open Recent Projects from the Getting Started Window
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Step 2: Adding Placement Constraints

Explore some of the design hierarchy, and begin placing logic elements to create physical constraints.

1. From the Flow Navigator, select Open Synthesized Design. The synthesized design might already
be open if you came directly to this step.

The synthesized netlist opens with the Device window displayed.
2. Select the Netlist window and expand the clkgen hierarchy.
3. Expand the Leaf Cells folder and select the instance mmcm_adv_inst (MMCME2_ADV).

Sources | Netlist x ? 00
A 2
5 top -
b Mets (4432
> Leaf Cells (223
~ clkgen (clock_generatar

> MNets (18

hd Leaf Cells (10

il clkf_buf (BUFG

il clkout1_buf (BEUFG
il clkout2_buf (BUFG
il clkout3_buf (BUFG
[l clkoutd_buf (BUFG
il clkouts_buf (BUFG
il clkouté_buf (BUFG

il GMD (GMD
il mmecm_adv_inst (MMCMEZ2_ADV)
Ll VCC (VCC

» cpuEngine (or1200_top
> fEngine (ffTop
> [E matEnaine (matTon v

Figure 31: Netlist Window

4. Look in the Cell Properties view, under the Properties tab, and notice that the STATUS is UNPLACED,
and there are no IS _LOC FIXEDor IS BEL FIXED properties shown.

5. Check this in the Tcl Console by typing:
get property IS LOC FIXED [get cells clkgen/mmcm adv_inst]

This returns a zero, indicating the object is not fixed to a location.
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Lab 2: Setting Physical Constraints

Zoom into the bottom right of the Device view, to display the lower half of Clock Region X1YO, to
prepare for placing the selected object. See the following figure.

Tip: It is easier to place logic in the Device window if Routing Resources are not

displayed. If they are displayed, select the Routing Resources toolbar button 1o
disable.

SYNTHESIZED DESIGN lab1 | xc7K70tfbgB76-2 (active)

v v v w

Cell Properties

General Properties MNets Cell Pins

Netlist Device

=4 # |- Q@ 1 & O IR EH & =]
il clkout1_buf (BUFG ™
il cdkoutz_buf (BLFG
il clkout3_buf (BUFG
il clkoutd_buf (BUFG
il cdkouts_buf (BLFG
il clkout6_buf (BUFG
il GND (GNL:
il mmecm_adv_inst (MMCMEZ_ADV)
il VCC (VCC
cpuEngine (or1200_top
fEngine (fiTop
mgtEngine (matTop
[A@l n=hFnninan (=nhf tnn ~

il mmem_adv_inst ﬂ

Q = s 4= + o
FILE_NAME C:NVivado_Tutorialiproject_cpu_netlistipra ™
15_BLACKBOX
15_DEBUGGABLE v
I5_ORIG_CELL
I3_PRIMITIVE v
I5S_REUSED

Figure 32: Placing the MMCM

In the Netlist window, click on the mmem_adv_inst and drag it into the Device window to place it
into the bottom right MMCME2_ADV.

Look in the Tcl Console. You should see something like these three commands:

startgroup
place cell clkgen/mmcm adv_inst MMCME2 ADV_ X1YO0/MMCME2 ADV
endgroup

The startgroup and endgroup Tcl commands bracket sequences of commands to support the
undo function in the Vivado tools. If you make a mistake, you can use the undo command in the Tcl
Console, or the Edit > Undo command. This will undo the placement and allow you to redo it. For
more information on startgroup, endgroup, and undo, refer to the Vivado Design Suite Tcl
Command Reference Guide (UG835).
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9. Look at the Properties tab of the Cell Properties window for the MMCM cell you placed.

Notice that the IS BEL FIXEDand IS LOC FIXED properties are now checked, reflecting that
the object has been placed, as shown in the following figure. The STATUS property is set to FIXED
as well.

O Tip: The Cell Drag and Drop mode in the Device window determines whether only
IS LOC FIXEDIs set, or IS BEL FIXED is also set, when placing objects. Refer to
this link in the Vivado Design Suite User Guide: Using the Integrated Design
Environment (UG893) for more information on using the Device window.

Cell Properties ?7 = O0 X
L8 mmcm_adv_inst 'ﬂ'
Q = & @& + o X

DIVCLK_DIVIDE 1 -
FILE_NAME C:MVivado_Tutorialiproject_cpu_net
IS_BEL_FIXED 7

15_BLACKBOX

I5_DEBUGGABLE v

I5_LOC_FIXED ¥

I5_ORIG_CELL

1S PRIMITIVE W ~

General Properties Mets Cell Pins

Figure 33: BEL and LOC Placement Constraints

The IS BEL FIXEDand IS _LOC_FIXED properties on the object are physical constraints
reflecting the placement of the object. These constraint are used by Vivado implementation, and will
not be changed by the tool. However, if the properties are invalid, they will cause errors
downstream in the design flow.

1
Notice that when you place mmcm_adv_inst in the Device window, the Save Constraints button H
is enabled. The physical constraints are added to the Vivado tool in-memory design, but are not yet
saved to the target constraint file.
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Step 3: Defining Additional Physical Constraints

In this step you will define additional physical constraints to the design, such as the PACKAGE PIN, and
PROHIBIT constraints.

1. Select Layout > 1/0 Planning to open the I/O Planning view layout from the Layout Selector in the
tool bar menu.

The I/0O Planning view layout displays the Package window, as well as the I/O Ports and Package
Pins windows, to facilitate planning the 1/O port assignment for the design.

For the purposes of this tutorial, assume the PCB layout has been completed, and therefore certain
pins are not accessible on the FPGA package. You can prohibit the Vivado tool from using these
pins during placement and routing (assuming you have not already specified all of your 1/0
assignments).

2. Select the AA8 pin in the Package window.

Tip: Use the X and Y-axis values on the edge of the Package window to help you
locate this pin on the package.

3. With the pin selected, right-click and select Set Prohibit.

Figure 34: Package Pin A8

When you unselect the pin, you will notice the site now has a red circle with a diagonal line through
it, indicating that it is unusable.

4. Look in the Tcl Console and review the TCL command produced by the Vivado IDE:

startgroup

set property prohibit 1 [get bels IOB X1Y34/PAD]
set property prohibit 1 [get sites AAS8]

endgroup
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Step 4: Defining Constraints with Object Properties

You can create timing and placement constraints as you have seen in this tutorial. You can also change
the properties of cells to control how they are handled by Vivado implementation. Many physical
constraints are defined as properties on a cell object.

For example, if you discover a timing issue with a RAM in the design, to avoid resynthesis, you can
change a property of the RAM cell to add in pipeline registers. After confirming with the designer and
validation teams that this is an acceptable approach, you can change the design.

Setting Cell Properties

Because it can be too time consuming and costly to go back to the RTL after synthesis, you can make
changes in the netlist as follows.

1. Select Edit > Find to open the Find dialog box, seen in the following figure.
a. Specify Find Cells.
b. Under Properties, set PRIMITIVE_TYPE to BMEM.BRAM.
c. Make sure that Search Hierarchically is selected, as shown in the following figure.

d. Click OK.

Find objects in the current design or device by filtering Tcl properties and objects. ‘

Result name: | find_1

FEind: Cells w

Properties
PRIMITIVE_TYPE w| |is ~ | BMEM.BRAM hd | +
Reqgular expression ~ Search hierarchically

Of objects: IZ‘

Command: show_objects -name find_1 [get_cells -hierarchical filter { PRIMITIVE_TYPE =~ BMEM.bram.* } |

< Openin anewtab

Figure 35: Find Dialog Box

The Find Results window opens.
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2. Select the Show Search button Q on the toolbar menu of the Find Results window.

3. Search for ingressLoop, and select the following cell:
fftEngine/fftInst/ingressLoop|[7].ingressFifo/

In the Properties tab of the Cell Properties window, you can see the DOA REG and DOB_REG are set
to zero, indicating that the output registers are disabled.

4. Generate a custom timing report from this cell directly from the Tcl Console. The Tcl command to
enter is:

report timing -from [get cells fftEngine/fftInst/ingressLoop[7].ingressFifo/
buffer fifo/infer fifo.block ram performance.fifo ram reg]

O Tip: You can copy and paste the cell name from the General tab of the Cell Properties window
into the Tcl console.

O

5. In the upper-right corner of the Tcl console, click the Maximize button to maximize the

window and better view the timing report.

6. In the data path section of the report, 1.800ns is added by this RAMB.

RAMBIGEL (Prop_ramb36el_CLKBWRCLK_DOEDO[L6])
1.800 -0.526 r fftEngine/fftInst/ingressLoop[7].ingressFifosbuffer_fifolinfer_fifo.block_ram_performnance.

net (fo=2, unplaced) 0, 466 -0.061 TrInst/TOBTT[15]_55[0]

DSP48EL r transformLoop[7].ct/x0utReg_reg/A[0]

7. Restore the Tcl Console to its normal size.

8. In the Properties tab of the Cell Properties window, select the DOA_REG and DOB_REG properties
for this cell, and change their values from "0" to "1".

You can see the two set property commands run in the Tcl Console.

set property DOA REG {1} [get cells {fftEngine/fftInst/ingressLoop[7].ingressFifo/
buffer fifo/infer fifo.block ram performance.fifo ram reg}]

set property DOB_REG {1} [get cells {fftEngine/fftInst/ingressLoop[7].ingressFifo
/buffer_fifo/infer_fifo.block_ram_performance.fifo_ram_reg}]

9. Rerun the timing report from the selected cell. The Tcl command to enter is:

report timing -from [get cells fftEngine/fftInst/ingressLoop[7].ingressFifo
/buffer fifo/infer fifo.block ram performance.fifo ram reg]

10. Notice that the data path delay for the RAM is now 0.622 ns.

Setting Design Properties

Next, set the configuration mode on the design. This is another property that results in a physical
constraint, in this case a property of the design rather than of a cell. To begin, list all of the properties of
the current design.
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1. List the properties of the design in the Tcl Console:

list property [current design]

This command returns the list of all defined properties on the current design. To make the list more
readable, you can use the standard Tcl join command to combine the properties output with “\n”
newline character, resulting in each property displaying on a separate line.

join [list property [current design]] \n

2. The specific property of interest is CONFIG_MODE. To see what values this particular property can
accept, use the 1ist property value Tcl command:

join [list property value CONFIG MODE [current design]] \n

3. Use the Tools > Edit Device Properties command to set the CONFIG_MODE property for the
current design.

The Edit Device Properties dialog box opens.
4. Click Configuration Modes to open the Configuration Modes panel.

5. Scroll down on the page to find the Master Serial configuration mode option, as shown in the
following figure.

Edit Device Properties

Use this dialog to edit the programming and configuration properties for your current design; default values are set automatically.

Configuration Modes
General Select up to two device configuration modes. JTAG is always selected. Selecting a check box assigns a
Configuration mode and clicking an image displays details.
Configuration Modes
Startup Prohibit usage of the configuration pins as user /0O and persist after configuration
Encryption Reset configuration mode C'
Readback 1 -
— M[2:0]
DOUT f—
— DIN
— INIT_B
— PUDC_B
— PROGRAM_B
DONE [—
— CCLK
Master Serial

Figure 36: Edit Device Properties - CONFIG_MODE
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6. Select the Master Serial configuration mode as shown, and click OK to close the dialog box.

The Tcl console shows the set property command that sets the CONFIG_MODE:
set property CONFIG MODE M SERIAL [current design]

The configuration mode has now been set.

7. Use the get property command to confirm that the CONFIG_MODE property was correctly set:
get property CONFIG MODE [current design]

The property value M SERIAL is returned by the Vivado tool.

Step 5: Saving Constraints

Notice that the Save Constraints icon is enabled because there are new design constraints. The cell and
design properties you modified in Lab #2 have been added to the Vivado tool in-memory design, but
are not yet saved to the target constraint file.

1
1. Click the Save Constraints button H
The physical constraints you defined in Lab #2 are saved to the target constraint file.

2. Select the target XDC (in this case, timing.xdc) from the active constraint set in the Sources
window to open the file in the Vivado IDE text editor.

Note: You might need to click on the Reload link to update the file if it is already opened in the
GUI.

Notice that the seven set property commands you used in Lab #2 are saved to the constraint
file. Only design constraints are written to the XDC file, not the object queries or reporting
commands that you also used in this lab.

3. Look for the following constraints in the open constraint file:

set property BEL MMCME2 ADV [get cells clkgen/mmcm adv_inst]

set property LOC MMCME2 ADV X1Y0 [get cells clkgen/mmcm adv_inst]

set property PROHIBIT true [get bels IOB X1Y34/PAD]

set property PROHIBIT true [get sites AA8]

set property DOA REG 1 [get cells \
{fftEngine/fftInst/ingressLoop[7].ingressFifo/buffer fifo/infer fifo.block ram \
performance.fifo ram reg}]

set property DOB REG 1 [get cells \
{fftEngine/fftInst/ingressLoop[7].ingressFifo/buffer fifo/infer fifo.block ram \
performance.fifo ram reg}]

set property CONFIG MODE M SERIAL [current design]

4. Exit the Vivado IDE.
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Conclusion

In this lab, you learned how to use both the Vivado IDE and the Tcl Console to create and verify physical
constraints. Most actions performed in the IDE result in Tcl commands being run in the Tcl Console. The
Vivado IDE provides powerful interactive capabilities for developing physical and timing constraints,
which can then be saved to constraint files and reused as needed.
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